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This symbol, found on your product or on its packaging, indicates that
this product should not be treated as household waste when you wish

e [0 dispose of it. Instead, it should be handed over to an applicable
collection point for the recycling of electrical and electronic equipment. By
ensuring this product is disposed of correctly, you will help prevent potential
negative consequences to the environment and human health, which could
otherwise be caused by inappropriate disposal of this product. The recycling of
materials will help to conserve natural resources. For more detailed information
about the recycling of this product, please contact your local city office, household

waste disposal service or the retail store where you purchased this product.

¥ This equipment obtained certification by using 1.5M serial cable.
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1 Overview

1.1 Overview

PBH-104 is a programmable device for industrial network communication. You can
build various systems which are based on network using PBH-104 with many kinds of

devices such as a personal computer.

We provide a self-development programming language, which is called PHPoC, for
programing PBH-104. This language is easy to use and compatible with PHP which is

widely used script language.

< PHPoC is basically compatible with PHP but those languages are not the
same because of restrictions about embedded system. Please refer to the
PHPoC Language Reference Manual and PHPoC vs PHP for detailed

information.

1.2 Features

® Provides Self-Development PHPoC Interpreter

® Provides simple development environment via USB

® Provides 4 serial ports with RS232/RS422/RS485 interfaces
® Provides 10/100Mbit Ethernet

® Provides IEEE802.11b/g Wireless LAN

® Provides development tool for Windows

@@'— SOLLAE SYSTEMS -5- http://www.eztcp.com
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1.3 Specification

Input DC 5V (£0.5V)
Power
Current about 242mA (without USB WLAN adapter)
Dimension 180mm x 90mm x 24mm
Weight about 417g (without USB WLAN adapter)
4 x RS232/RS422/RS485
Serial (Baud Rate: COM1, COM4 - 2,400bps ~ 230,400bps
COM2, COM3 - 1,200bps ~ 230,400bps)
10 Base-T / 100 Base-TX Ethernet
Interfaces Auto MDI/MDIX (cable auto-sensing)
Network
IEEE802.11b/g
(require Ralink RT3070/5370 chipset WLAN adapter)
USB Host - for WLAN adapter
usB
USB Device - for PC
Firmware PHPoC Interpreter
Storage
Temperature -40 ~ 85°C
/Operating
Approval KC, CE, FCC
Environment RoHS Compliant
Software PHPoC Debugger, PHPoC Writer

Table 1-1 specification

SOLLAE SYSTEMS -6 - http://www.eztcp.com
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1.4 Dimension
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Figure 1-1 dimension

= Dimensions may vary according to a method of measurement.
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1.5 Interface

1.5.1 Panel Layout

PBH-104

SOLLAE SYSTEMS

Figure 1-2 panel layout

@ LED PWR, STS, A~H

@ Ethernet port: 10/100M

® USB host port: USB WLAN adapter connection

@ USB device port (Setup): PC connection, DC 5V power supply
® Power port: DC 5V

® Function button (Func)

@ Serial ports: RS232 / RS422 / RS485

@ SOLLAE SYSTEMS -8 - http://www.eztcp.com
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1.5.2 LED
LED Name Action
Power LED PWR turned ON with stable power supply
running PHP
> repeat On and Off in every second
Status LED STS

not running PHP

> briefly blinks 1 time at a time

User-defined LED A~H follows definition on user script

Table 1-2 LED

1.5.3 USB Device Port for connection with PC

USB device port is to connect with PC. You can access to products via development

tool with connecting USB cable to this port.

Moreover, you can supply DC 5V power to your product through this port.

1.5.4 Function Button (Func)

Function button is used for changing mode to button setup mode.

1.5.5 Supplying Power

PBH-104 provides following two ports for supplying power. Thus, you can choose at

least one port for supplying power.

® Power port (DC 5V)

Power port uses DC 5V and its specification is as follows:

26.3

@ 9 -

Figure 1-3 specification of power port

SOLLAE SYSTEMS -9- http://www.eztcp.com
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® USB device port (Setup)

You can supply DC 5V power through this port. Product's operation may be

abnormal in case of supplying power via this port only with insufficient current.

1.5.6 USB Host Port for Connection with WLAN adapter

PBH-104 provides a USB host port for an USB WLAN adapter. You can connect your
product to Wireless LAN by connecting WLAN adapter to this port.

< Caution: Only adapters using Ralink RT3070/5370 chipsets are available.

& Caution: WLAN cannot be used with Ethernet at the same time.

1.5.7 Serial

PBH-104 provides four serial ports. Each port is interfaced to D-SUB 9pin male
connector and you can select the type of RS422, RS485 or RS232. Uploading PHPoC

codes to your product is required to set the type of serial.

O\ o JO

Figure 1-4 serial

< Please refer to the PHPoC Device Programming Guide for detailed

information about setting type of serial.

® Serial Port Specification

Parameter Value

The number of port | 4

Serial Type RS232 / RS422 / RS485

Baud rate 2,400(COM2, COM3 - 1,200) ~ 230,400 [bps]
Parity NONE / EVEN / ODD / MARK / SPACE

Data bit 8 or 7(7 data bit is only available on using Parity)
Stop bit lor2

Flow control NONE, RTS/CTS

Table 1-3 serial port specification

SOLLAE SYSTEMS -10 - http://www.eztcp.com
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Pin | Name | Description Level I/O | Note

1 DCD Data Carrier Detect RS232 | - N/A

2 RXD Receive Data RS232 | In basic

3 TXD Transmit Data RS232 | Out | basic

4 DTR Pata Terminal Ready RS232 | Out | optional

(always output active signal)

5 GND Ground - - basic

6 DSR Data Set Ready RS232 | - N/A

7 RTS Request To Send RS232 | Out | optional
8 CTS Clear To Send RS232 | In optional
9 RI Ring Indicator RS232 | - N/A

Table 1-4 RS232 pin assighment
® RS422 pin assighment

Pin Name Description Level I/0 Note

9 X + Transmit Data + RS422 Out basic

1 TX - Transmit Data - RS422 Out basic

4 RX + Receive Data + RS422 In basic

3 RX - Receive Data - RS422 In basic

5 GND Ground - - basic

Table 1-5 RS422 pin assighment
® RS485 pin assignment

Pin Name Description Level I/0 Note

9 TRX + Data + RS485 In/Out | basic

1 TRX - Data - RS485 In/Out | basic

5 GND Ground - - basic

Table 1-6 RS485 pin assignment

< Biasing Register (100K Q) is connected to RS422/485 line.

SOLLAE SYSTEMS
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1.5.8 Ethernet

PBH-104 has Ethernet port which supports 10/100M bit Ethernet. Both direct and

cross over cable can be used because it automatically detects the type of cable.

® LED of RJ45 Connector

LED Operation State
ON Connected to Network
Green OFF Not connected to Network
Blink Receiving or Transmitting Network Data
ON Connected to 100M Ethernet
Yellow
OFF Connected to 10M Ethernet

Table 1-7 LED of RJ45 connector

SOLLAE SYSTEMS -12 - http://www.eztcp.com



http://www.sollae.co.kr/

PBH-104 User Manual Ver. 1.0

1.6 Development Environment

1.6.1 Overview

PBH-104 provides development environment over USB. PHPoC Debugger, which is

development software, is required to program to your product or to debug PHPoC

source codes.

1.7 PHPoC Debugger

1.7.1 Program Overview

PHPoC Debugger is a software runs on Windows. This program does not require

installation. You can upload files to your product with this program through USB port.

Features of PHPoC Debugger are as follows:

Upload files from local PC to PHPoC product
Save files which are in PHPoC product to local PC
Edit files stored in PHPoC device

Debug PHPoC scripts

Monitor PHPoC product resources

Set PHPoC product

Upgrade Firmware of PHPoC product

SOLLAE SYSTEMS -13 - http://www.eztcp.com
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1.7.2 Program Structure

File Edit Functio

COM PORT |COMZ

CleSCEIER

Cilo lict

Flash Memory

Figure 1-5 program structure

http://www.eztcp.com
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@ Menu bar

Menu Sub menu Description
Open a poc file Open a poc format file

File Save selected file(s) Save selected files in file list to local PC
Save a poc file Save all files in file list to local PC (.poc)
Undo Undo the latest job
Redo Redo the latest job undone
Cut Cut selected text and copy it to clip board
Copy Copy selected text to clip board
Paste Paste text of clip board

Edit Select all Select all text
Find Find specified text
Find Next Find the next text by down direction
Find Previous Find the next text by up direction
Change Replace specified text with given text
Preferences Program preference
Product / Firmware Information of current firmware and
information product
Network information Current network information
Upgrade firmware Upgrade firmware
Reboot a product Reboot a product

Function | View firmware log view firmware log messages
Debug mode Enable / disable debugging mode
Font Change font
Language Change language
PHPoC Debugger
o rmation Information about PHPoC Debugger

Table 1-8 menu bar
SOLLAE SYSTEMS - 15 - http://www.eztcp.com
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® Preferences

Menu Sub menu Description
View margin Show / Hide margin
View line number Show / Hide line number on margin
View current line Enable / Disable current line emphasis
View
Auto scroll Enable / Disable auto scroll
Line ratio Set line space: 100, 120, 150, 200, 300
Tab size Set tabsize: 1, 2, 4, 8, 16
Internal editor PHPoC Debugger internal editor
Action of
External editor External editor
file add
Ask Show select option every time
Backup path Path of backup files
Enter initialization
Initialization Set product to initialization mode
mode

Table 1-9 preferences

@ COM PORT
Part for choosing a virtual USB COM port

(3® Buttons

Button Description

Connect to PHPoC product

Disconnect to PHPoC product

Configure environmental values of PHPoC product

Upload files on [File list] to PHPoC product

Stop running PHPoC codes

Run / Pause PHPoC codes

Run line by line

EESDEOBE

Run procedure by procedure

Table 1-10 buttons

SOLLAE SYSTEMS - 16 - http://www.eztcp.com
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List of files in PHPoC product or to be uploaded to it

Icon Description

- Synchronized files

i Files on PHPoC product before synchronization

—
-

Files on local PC before synchronization

1 - Synchronized files on local PC for external editors

Table 1-11 file list

Following menus will be popped up when right clicking on file list area.

Menu

Description

New

Create a new php file

Change the filename

Modify file name

Add

Add files from local PC

Delete

Delete file on the list

Table 1-12 pop up menu on file list

® Editor

Show and edit contents of selected file on the file list.

Following menus will be popped up when right clicking on editor area.

Menu Description Shortcut
Toggle Breakpoint Set / Unset break point on current line | F9
Remove All Breakpoints | Unset all break points on current file Shift+F9
Step Into Run line by line F11
Step Over Run procedure by procedure F10
Copy Copy selected codes to clip board Ctrl+-C
Paste Paste codes on clip board Ctrl+V

Table 1-13 pop up menu on editor

® Flash memory size

This shows currently available or in-use space on flash memory of PHPoC

product.

SOLLAE SYSTEMS
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Output or system console message windows

Following menus will be popped up when right clicking on the windows.

Menu

Description

Delete all logs

Clear screen buffer

Copy a log

Copy selected log to clip board

Auto scroll

Set / Unset auto scroll

Table 1-14 pop up menu on output / console window

Watch / Resource
Show variable information and system resources

Following menus will be popped up when right clicking on the watch box.

Menu Description
Add Add a variable
Modify Modify a name of selected variable
Delete Delete selected variables
Delete all Delete all variables
Detail Create a new window for detailed information
Refresh Refresh variables
Table 1-15 pop up menu on watch box
SOLLAE SYSTEMS -18 - http://www.eztcp.com
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2 Test Run

This chapter instructs procedures of making a simple program which prints "Hello
PHPoC."

2.1 Development Environment Construction

2.1.1 Local PC

To upload php files to PHPoC product, a MS windows PC is required to upload php
files to PHPoC product, although creating and modifying php files are available on

other operating systems.

2.1.2 Connecting PBH-104

Connect PBH-104 to PC with USB cable.

2.1.3 Running PHPoC Debugger

Run PHPoC Debugger on the PC.

< This document defines "Upload"” to "Sending files from PC to PHPoC

product.”

PBH-104

5

-_
EF RAEL

Local PC

Upload

Figure 2-1 definition of upload

@'@- SOLLAE SYSTEMS -19 - http://www.eztcp.com
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2.2 Connecting Product

2.2.1 Connecting Product

Connect PBH-104 to your PC via USB cable.

<  Device driver will be automatically installed when you connect PBH-104 to
your PC. When automatic installation fails, download and install the driver

on ST Micro's web site.

< STM32 USB Virtual Com Port Driver Download page:
http://www.st.com/web/catalog/tools/FM147/CL1794/5C961/SS1533/PF
257938

2.2.2 Ready to Communicate

@ Run PHPoC Debugger

@ Select connected COM PORT and press connect (-’) button.

® If USB is successfully connected, connect button will be inactivated and

disconnect button (m) will be activated.

SOLLAE SYSTEMS - 20 - http://www.eztcp.com
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2.3 Practice

2.3.1 PHPoC Operation

PHPoC products searches "init.php" file right after it boots up. If there is no
"init.php" file, any of PHPoC code will not be run. Thus, you must create "init.php" file

to PHPoC product first.

You can write script on the "init.php" as well as run other php files using php
command of system function. "init.php" runs once but loaded files by system function

can be repeatedly run.

& Please refer to the PHPoC System Function document for detailed

information about system function.

® Running script on "init.php"

init.php

<?php

7=

Figure 2-2 running script on "init.php"
® Running another php file in "init.php"

init.php a.php

<?php <?php
system(”“php a.php");

T

T

Figure 2-3 running another php file in "init.php"

SOLLAE SYSTEMS -21 - http://www.eztcp.com
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® Script run flow chart

C D

Search "init.php”

Success?

Yes

Start to run "initphp”

load php file?

Yes

Y

Run loaded php (Repeat) —( End )

Figure 2-4 flow chart of script run

= "init.php" is start of all scripts. It means that every php file is directly or

indirectly required to be loaded on "init.php" to run it.

SOLLAE SYSTEMS -22 - http://www.eztcp.com
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2.3.2 Create "init.php"

® Right click on file name area of PHPoC Debugger.

F ™y
&S PHPoC Debugger Elﬂlg

File Edit Function
COM PORT | COMS (]G
EJEDEIED| :

File list
Right Click |

Mew

C-hange- the filename

Add 3
Delete
-
i >
Output | Console Watch | Resource

Name Type

« | 1 3

Figure 2-5 create "init.php" (1)
® Click [New] menu
® Click [Create] after type "init" in file name box.

[ New S

Filename  init

[ e | o

Figure 2-6 create "init.php" (2)

® Check if "init.php" is shown on the file list.

COM PORT | COMS lm | »|[=]|[E]
CTaE
File list 3

Figure 2-7 create "init.php" (3)
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2.3.3 Printing Hello PHPoC

Following steps instruct how to print "Hello PHPoC" message to console.

® Modify "init.php" as figure below.

1 <?php
2lecho "Hello PHPoCh\riyn";
32
Figure 2-8 Hello PHPoC (1)

Click upload (-) button.

After uploading, the icon in file list will be changed. (# — #)
Click run () button.

Check if "Hello PHPoC" is printed in output box.

Output | Console

Hello PHPoC

Figure 2-9 Hello PHPoC (2)

2.3.4 Reconnecting Product

When you connect products via PHPoC debugger, all files in the product will be

automatically listed on the file list.

® Delete "init.php"

Select "init.php" on the file list and delete it by right clicking.

File list

MNew

k Change the filename
Add 3
Delete

Figure 2-10 reconnecting product (1)

® If you click connect button (-=') after clicking disconnect ( ) button,
PHPoC Debugger will show "init.php" file on the file list.
File list

| init.ohp E

Figure 2-11 reconnecting product (2)
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2.4 Saving Files to PC

2.4.1 Saving File to PC

® Select files in file list

File list

S o

Figure 2-12 saving files to PC (1)

® Click [File] > [Save selected file(s)]Jmenu on menu bar

Edit Function

Open a poc file

Save selected file(s)

Save 3 poc file

Figure 2-13 saving files to PC (2)

® Choose a path and click [OK] button.

-
Browse For Folder u

Select a folder to save to,

I |4 Libraries
& Roy —
a7 Computer
I <4 Floppy Disk Drive (A:)
| &L, Local Disk (C:) |
I 5 DVD Drive (D)
[ fj Metwork

m

1

Folder: Local Disk {C:)

[Make Mew Folder ] Ok Il Cancel |

Figure 2-14 saving files to PC (3)
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® When you want to save all files on the file list as a single file, use [Save a poc

file] menu.

Edit Function

Cpen a poc file

Save selected file(s)

Save a poc file

Figure 2-15 save as a poc file (1)

".poc" is filename extension. Input filename and click [Save] button.

J? Music

& -
[ Pictures Y ! MNetwark
B2 Videos - I| System Folder

r ™
R Save As ﬂ
%v|- Desktop » - | 44 | | Search Desktop o |

Organize New folder B ~ (7]
W Favorites i G | hraries -
BE Desktop || System Folder
4 Downloads :
2| Recent Places 1 Roy
& System Folder -
4 Libraries
ﬁ@ : | Computer
Documents | Systern Folder

l File name: test I

Save as type: | POC File(*.poc]

“ Hide Folders

@ SOLLAE SYSTEMS

Figure 2-16 save as a poc file (2)
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2.5 Upload Files to Product

Php files in local PC can be uploaded to PHPoC products.

2.5.1 How to Add Files to File list

® Drag & Drop

Select and drag files on Window explorer to file list box and drop them.

Organize v | Open Share with v PrJ - - -
ile Edit Function
¢ Favorites Documents librafl| com porT [com? @ m
— Desktop Source _— =
& Downloads S 2 D il
= Recent Places — File list
| init.php.+* v
4 Libraries SR §
<] Documents Drag '-..
@' Music 5
b=/ Pictures % Drop
B \idenr

Figure 2-17 add files to file list (1)

® Add menu

If you click [Add] after right-clicking in file list box, a window for selecting files

will be created. Selected files on the windows will be added to the file list.

File list
Right Click
t} Mew
Change the filename
Add »
Delete

Figure 2-18 add files to file list (2)

< Integrated file(.poc) should be added by [File]>[Open a poc file] menu only

2.5.2 Upload files

Files in the file list will be uploaded to product by clicking upload (-) button. If
the uploading is completed, both files on the file list and in the product are

synchronized with changing (#) icons

File list

F
[ init.php =
test php 3

Figure 2-19 upload files
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3 Management

3.1 Configure Parameters

All parameters including IP address can be configured by PHPoC Debugger.

3.1.1 Configuration Procedure

@ Connect PHPoC product to PC
@ Run PHPoC Debugger and click connect () button.

® After then, click configuration (ﬁ) button.

= Sometimes you can see inactivated configuration button. In this case, click

stop ( n) button before configuration.

@ Configure parameters

Settings - PBH-104 e S
Metwork | wireless LAM

IPv4
Local IP Address

() Use static IP address
Subnet Mask (@ Obtain an IF Automatically(DHCF)

Obtain DMS Server Address Automatically

Gateway IP Address

DNS IP Address

IPvd

lUse static IP address

ELI (@ Obtain an IP Automatically

|I'~"IAC Address - |

Local IP Address |

|
Gateway IP Address | |
DNS IP Address | |

| Password | | Certificate || write | | Cose |

Figure 3-1 configuration window
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Tab Category | Parameter

IP address

Subnet mask

Gateway IP address

IPv4
DNS server IP address

IP address type - Use static IP address

IP address type - Obtain an IP automatically (DHCP)

Network
automatically

IP address type - Obtain DNS server address

Disable / Enable

IP address type - Use static IP address

IP address type - Obtain an IP automatically

IPv6

EUI - MAC Address / random

IP address type - Use static IP address

IP address type - Obtain an IP automatically

WLAN Topology - Ad-hoc / Infrastructure / Soft AP

Channel

Basic
SSID

Wireless | Settings

Internal Antenna / External Antenna

LAN
Advanced Settings
Security Shared Key
Settings 802.1X: EAP-TLS / EAP-TTLS / PEAP
Password | Password (ID: Admin)
Write self-signed certificate
Buttons
Certificate | Write signed certificate from certification authorities
Read the certificate form a device
Table 3-1 system parameters
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3.2 Initialization

3.2.1 Levell

Implementing level 1 initialization, both system parameters and user parameters
including stored certificate will be initialized to factory state. However, password and

file system will not be changed.

® Level 1 Initialization Procedure

Step | Action Product State STS LED

Press function button shortly
1 Button setup mode On
(less than 1 second)

Keep pressing the function Blink very
2 Preparing initialization

button over 5 seconds rapidly
3 Check STS LED after 5 seconds | Initialization ready Off

After the step 3, release the

function button within 2 seconds S
4 Progressing initialization | On
(After 2 seconds elapsed, state

go back to the step 3)

5 Rebooting automatically Initial state Off

Table 3-2 level 1 initialization procedure

< WLAN easy setup function will be activated in the button setup mode in
level 1 initialization. Thus, STS LED can be blink if a wireless LAN client is
linked.
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3.2.2 Level 2

Implementing level 2 initialization, all parameters including user password and file

system is initialized to factory state.

= Level 2 initialization should be used very carefully. Note that you had better
to back up you files to local PC before doing this because they will be
deleted.

® |evel 2 Initialization Procedure

Step | Action Product State STS LED

Set PHPoC to initialization mode
Enter Initialization mode | Blink

1 (Use [Edit]>[Preferences] menu
after reboot rapidly
on PHPoC Debugger)
Keep pressing the function button Blink very
2 Preparing initialization
over 10 seconds rapidly
3 Check STS LED after 10 seconds Initialization ready Off

After the step 3, release the

function button within 2 seconds S
4 Progressing initialization | On
(After 2 seconds elapsed, state

go back to the step 3)

5 Initialization is finished Initial state Off

Table 3-3 level 2 initialization procedure
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3.3 WLAN Easy Setup

Product enters into button setup mode when you push function button in normal
state. In the mode, WLAN easy setup function is activated if an USB WLAN adapter is

connected so you can access to your product by smartphone or laptop by WLAN.

3.3.1 SSID

Once WLAN easy setup function is activated in button setup mode, product uses
SSID including own MAC address like an AP. SSID is contained the second half of the

product's MAC address after "phpoc_
address is "0030f9060101", the SSID is "phpoc_060101".

which is a prefix. For example, if the MAC

3.3.2 WLAN Connection

Find your product's SSID via a smartphone or laptop.

phpoc_060101 o ‘ |

Figure 3-2 WLAN connection

3.3.3 DHCP

While using WLAN easy setup function, a mobile automatically gets a dynamic IP
address from your product. Product's IP address is fixed to 192.168.0.1 and mobile

obtains an IP address in 192.168.X.X range.

3.3.4 Access to Product

After uploading setting page to product, you can access to it by web browser.

senne SKT = PM 5:46 0 100% -+
| 192.168.0.1 c)

SKT B4 0@ = allsox @ PM 5:47

I 192.168.0.1

PBH-104

SETTIN

System Information

Product name PBH-104 e il

< WLAN easy setup function is available on connecting a USB WLAN adapter.
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3.4 Web Interface

PHPoC provides web interface regardless of script execution. TCP 80 is used for
web interface and you can use the interface via Internet Explorer, Chrome or another

web browser.

3.4.1 Procedure

® Uploading Web pages

Upload an "index.php" file to files system of PHPoC with codes as follows:

<html>
<body>
Hello PHPoC
</body>
</html>

® Connecting to Web page

Connect to the web page by entering the product's IP address on a web browser.

- —

€« C A ([1192.168.0.1 ) S| @y =

| Hello FHFoC

Figure 3-4 connecting to web page (1)

If the file name is not "index.php", just file name with its path after the IP

address as follows:

'\.‘J hhhhhhhhhhhh Sl L - |Ilh
€ C [ 192.168.0.1/a.php | T2 €5

e —

Figure 3-5 connecting to web page (2)

3.4.2 Practical Use of Web Interface

Web interface is very useful because it runs while product is operating in button
setup mode. If you upload web pages for product settings like the figure 3-3, you can

configure the product easily by wireless LAN.
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3.5 Firmware Upgrade

3.5.1 Download Firmware File

Check and download firmware file on PHPoC web site to your local PC.

3.5.2 Firmware Upgrade
@ Connect setup port of PHPoC product to local PC via USB cable.

|
@ Run PHPoC Debugger and click connect (-“) button.

® Click [Function] > [Upgrade Firmware] menu.

"
=2 PHPoC Debugger
File Edit || Functicn

COM POR Product/Firmware information G=

Metwork information

E] . Upgrade firmware

Fila lict I

Figure 3-6 firmware upgrade (1)
@ Click [Open] button to select the firmware file.

i 5
Upgrade firmware ﬁ

[Patn - |1 open

| | Send

Figure 3-7 firmware upgrade (2)

® Click [Send] button.

r B
Upgrade firmware [

[Path : Z\6 PHPOC\stm32f4P20R10A_77POC || Open |

| |I Send I

Figure 3-8 firmware upgrade (3)

® Firmware Upgrade Completed.

i ™
PHPoC Debugger ﬁ
I Firmware has been transmitted.
b

Figure 3-9 firmware upgrade (4)
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3.6 Etcetera

3.6.1 Debug Mode

PHPoC automatically runs script right after it boots up. However, if you don't want

to run immediately, you can prevent it.

-
E= PHPoC Debugger

File  Edit ﬁ

COM POR Product/Firmware information G= —

Metwork information

Upgrade firmware

File list Reboot a product

Wiew firmware log
Iv’ Debug mode I

Font

Figure 3-10 enable debug mode (1)

When enabling debug mode, PHPoC pause running script at the first line.

-
E= PHPoC Debugger
File Edit Function

COM PORT | COMS n n
ol o o (B

File list 30

Figure 3-11 enable debug mode (2)
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In case that you want to use not PHPoC Debugger's internal editor but external

editor, just set [External editor] option of [action of file add] item on preferences

window.

File it § Function

col Undo

E Cut

File

Select all

Find
Find Mext
Find Previous

Change

Ctrl+Z ' ) |

Ctrl+Y

Cirl+X
Cirl+C
Cirl+V

Ctrl+A

Ctrl+F
F3
Shift+F3
Ctrl+H

<?php

=

Preferences !—’

-
Preferences

View
View margin
Wiew line number
View current line
Auto scroll

Line rato
Tab iz

Action of file add
() Internal editol

i) Ask

Badkup path

k:WUsers"J'ﬁ"RoyWDnmmentsWPHPnCD

Initialization
(| Enter initialization mode

Change

Apply ] [ Cancel

Figure 3-12 using external editor (1)

Upload php files with this option, synchronized files have lock icons as follows. Files

with this icon cannot be modified by PHPoC Debugger's internal editor but external

editors available.

File list

[ init.php
testphp

EH

Figure 3-13 using external editor (2)
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4 Technical Support and Warranty

4.1 Technical Support

Sollae Systems operates PHPoC forum web site. This forum is for solving problem,

asking questions and sharing opinions among PHPoC users.

® PHPoC Forum: http://phpoc.com

4.2 Customer Support

If you have any question regarding products, service and others, visit message

board of Customer Support on Sollae Systems’ web site or send us an email:

® Website Address for Customer Support: http://www.eztcp.com/en/support/

® E-mail: support@eztcp.com

4.3 Warranty

4.3.1 Refund

Upon the customer’s request to refund the product within two weeks after

purchase, Sollae Systems will refund the product.

4.3.2 Free Repair Services

For product failures occurring within two years after purchase, Sollae Systems
provides free repair services or exchange the product. However, if the product failure
is due to user’s fault, repair service fees will be charged or the product will be

replaced at user’s expense.

4.3.3 Charged Repair Services
For product failures occurring after the warranty period (two years) or resulting
from user’s fault, repair service fees will be charged and the product will be replaced

at user’s expense.
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5 Precaution and Exemption from Liability

5.1 Precaution

® Sollae Systems is not responsible for product failures occurring due to user’s

alternation of the product.

® Specifications of the product are subject to change without prior notice for

performance improvement.

® Sollae Systems does not guarantee successful operation of the product if the

product was used under conditions deviating from the product specifications.

® Reverse engineering of firmware and applications provided by Sollae Systems
is prohibited.
® Use of firmware and applications provided by Sollae Systems for purposes

other than those for which they were designed is prohibited.

® Do not use the product in an extremely cold or hot place or in a place where

vibration is severe.

® Do not use the product in an environment in which humidity is high or a lot of

oil exists.
® Do not use the product where there is caustic or combustible gas.

® Sollae Systems does not guarantee normal operation of the product under the

conditions a lot of noise exists.

® Do not use the product for a purpose that requires exceptional quality and
reliability relating to user’s injuries or accidents — aerospace, aviation, health

care, nuclear power, transportation, and safety purposes.

® Sollae Systems is not responsible for any accident or damage occurring while

using the product.
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5.2 Exemption from Liability

5.2.1 English version

In no event shall Sollae Systems Co., Ltd. and its distributors be liable for any
damages whatsoever (including, without limitation, damages for loss of profit,
operating cost for commercial interruption, loss of information, or any other financial
loss) from the use or inability to use the PBH-104 even if Sollae Systems Co., Ltd.

and its distributors have been informed of such damages.

The PBH-104 is not designed and not authorized for use in military applications, in
nuclear applications, in airport applications, in applications involving explosives, in
medical applications, in security alarm, in a fire alarm, in applications involving
elevators, or in embedded applications in vehicles such as but not limited to cars,

planes, trucks, boats, aircraft, helicopters, etc.

In the same way, the PBH-104 is not designed, intended, authorized to test,
develop, or be built into applications where failure could create a dangerous situation
that may result in financial losses, damage to property, personal injury, or the death
of people or animals. If you use the PBH-104 voluntarily or involuntarily for such
unauthorized applications, you agree to subtract Sollae Systems Co., Ltd. and its

distributors from all liability for any claim for compensation.

Sollae Systems Co., Ltd. and its distributors entire liability and your exclusive
remedy shall be Sollae Systems Co., Ltd. and its distributors option for the return of

the price paid for, repair, or replacement of the PBH-104.

In no event shall Sollae Systems Co., Ltd. and its distributors be liable for loss of

user program codes which are stored in PBH-104.

Sollae Systems Co., Ltd. and its distributors disclaim all other warranties, either
expressed or implied, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose, with respect to the PBH-104

including accompanied written material, hardware and firmware.
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5.2.2 French version

® Documentation

La documentation du boitier PBH-104 est congue avec la plus grande attention.
Tous les efforts ont été mis en ceuvre pour éviter les anomalies. Toutefois, nous ne
pouvons garantir que cette documentation soit a 100% exempt de toute erreur. Les
informations présentes dans cette documentation sont données a titre indicatif. Les
caractéristiques techniques peuvent changer a tout moment sans aucun préavis dans

le but d'améliorer la qualité et les possibilités des produits.

® Copyright et appellations commerciales

Toutes les marques, les procédés, les références et les appellations commerciales
des produits cités dans la documentation appartiennent a leur propriétaire et

Fabricant respectif.

® Conditions d’utilisations et limite de responsabilité

En aucun cas Sollae Systems Co., Ltd. ou un de ses distributeurs ne pourra étre
tenu responsable de dommages quels qu'ils soient (intégrant, mais sans limitation,
les dommages pour perte de bénéfice commercial, interruption d'exploitation
commerciale, perte d’informations et de données a caractere commercial ou de toute
autre perte financiere) provenant de I'utilisation ou de I'incapacité a pouvoir utiliser le
boitier PBH-104, méme si Sollae Systems Co., Ltd. ou un de ses distributeurs a été

informé de la possibilité de tels dommages.

Le boitier PBH-104 est exclusivement prévu pour un usage en intérieur, dans un
environnement sec, tempéré (+10 °C a +40°C) et non poussiéreux. Le boitier PBH-
104 n’est pas prévu, ni autorisé pour étre utilisé en extérieur, ni de facon embarquée
dans des engins mobiles de quelque nature que ce soit (voiture, camion, train, avion,
etc:-+), ni en milieu explosif, ni dans des enceintes nucléaires, ni dans des ascenseurs,
ni dans des aéroports, ni dans des enceintes hospitaliers, ni pour des applications a
caractére médical, ni dans des dispositifs de détection et d’alerte anti-intrusion, ni
dans des dispositifs de détection et d‘alerte anti-incendie, ni dans des dispositifs

d’alarme GTC, ni pour des applications militaires.

De méme, le boitier PBH-104 n'est pas congu, ni destiné, ni autorisé pour
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expérimenter, développer ou étre intégré au sein d’applications dans lesquelles une
défaillance de celui-ci pourrait créer une situation dangereuse pouvant entrainer des
pertes financiéres, des dégats matériel, des blessures corporelles ou la mort de
personnes ou danimaux. Si vous utilisez le boitier PBH-104 volontairement ou
involontairement pour de telles applications non autorisées, vous vous engagez a
soustraire Sollae Systems Co., Ltd. et ses distributeurs de toute responsabilité et de

toute demande de dédommagement.

En cas de litige, I'entieére responsabilité de Sollae Systems Co., Ltd. et de ses
distributeurs vis-a-vis de votre recours durant la période de garantie se limitera
exclusivement selon le choix de Sollae Systems Co., Ltd. et de ses distributeurs au
remboursement de votre produit ou de sa réparation ou de son échange. Sollae
Systems Co., Ltd. et ses distributeurs démentent toutes autres garanties, exprimées

ou implicites.

Tous les boitiers PBH-104 sont testés avant expédition. Toute utilisation en dehors
des spécifications et limites indiquées dans cette documentation ainsi que les court-
circuit, les chocs, les utilisations non autorisées, pourront affecter la fiabilité, créer
des dysfonctionnements et/ou la destruction du boitier PBH-104 sans que la
responsabilité de Sollae Systems Co., Ltd. et de ses distributeurs ne puissent étre

mise en cause, ni que le boitier PBH-104 puisse étre échangé au titre de la garantie.

® Rappel sur I'évacuation des équipements électroniques usagés

Le symbole de la poubelle barré présent sur le boitier PBH-104 indique que vous ne
pouvez pas vous débarrasser de ce dernier de la méme fagon que vos déchets
courants. Au contraire, vous étes responsable de I'évacuation du boitier PBH-104
lorsqu’il arrive en fin de vie (ou qu'il est hors d’usage) et a cet effet, vous étes tenu
de le remettre a un point de collecte agréé pour le recyclage des équipements
électriques et électroniques usagés. Le tri, I'évacuation et le recyclage séparés de vos
équipements usagés permettent de préserver les ressources naturelles et de s’assurer
que ces équipements sont recyclés dans le respect de la santé humaine et de
I'environnement. Pour plus d’informations sur les lieux de collecte des équipements
électroniques usagés, contacter votre mairie ou votre service local de traitement des

déchets.
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6 Appendix

6.1 Device Information

6.1.1 Device overview

Device Number | Path Note

UART 4 /mmap/uart0~3

NET 2 /mmap/net0~1 0: wired, 1: wireless
TCP 5 /mmap/tcp0~4

UDP 5 /mmap/udp0~4

I/0 - Digital Output(LED) | 8 /mmap/io3

ST 4 /mmap/st0~3

@ SOLLAE SYSTEMS
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6.1.2 I/0 port

Type Path and Mapping information
/mmap/io3
LED #15 #14 #13 #12 #3 #2  #1 %0
H|G|F|E D|C|B|A
MSB ‘/mmap/io3” LSB
/mmap/io4
#15 #11 #7 #3 #0 _
[ uarT3 [ ART2 | UARTL [ uArTO | “/mmap/iod”
MSB ““““““ e u,
PBH-104 ¥ 5w #1 #0 ™,

SET SET SET SET
R5485 | 422 RE | RS422 | R5232

LSB

UART Mode ® Values for Serial Type

(Serial Type) SET SET SET SET
Type Value

RS485 422 RE | RS422 RS232

RS232 0x05 0 1 0 1
RS422 0x02 0 0 1 0
RS485 0x0c 1 1 0 0

® Setting Examples

Type All ports | UARTO UART1 UART2 UART3
RS232 0x5555 0x0005 0x0050 0x0500 0x5000
RS422 0x2222 0x0002 0x0020 0x0200 0x2000
RS485 0xCCCC | 0x000C 0x00CO0 0x0CO00 0xC000

Table 6-2 1/0 port

< Refer to the Device Programming Guide for detailed information about

using devices.
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2014.10.23 | 1.0 O Created Roy LEE
@3@- SOLLAE SYSTEMS -44 - http://www.eztcp.com



http://www.sollae.co.kr/

	1 Overview
	1.1 Overview
	1.2 Features
	1.3 Specification
	1.4 Dimension
	1.5 Interface
	1.5.1 Panel Layout
	① LED PWR, STS, A~H
	② Ethernet port: 10/100M
	③ USB host port: USB WLAN adapter connection
	④ USB device port (Setup): PC connection, DC 5V power supply
	⑤ Power port: DC 5V
	⑥ Function button (Func)
	⑦ Serial ports: RS232 / RS422 / RS485

	1.5.2 LED
	1.5.3 USB Device Port for connection with PC
	1.5.4 Function Button (Func)
	1.5.5 Supplying Power
	1.5.6 USB Host Port for Connection with WLAN adapter
	1.5.7 Serial
	1.5.8 Ethernet

	1.6 Development Environment
	1.6.1 Overview

	1.7 PHPoC Debugger
	1.7.1 Program Overview
	1.7.2 Program Structure
	① Menu bar
	② COM PORT
	③ Buttons
	④ File list
	⑤ Editor
	⑥ Flash memory size
	⑦ Output / Console
	⑧ Watch / Resource



	2 Test Run
	2.1 Development Environment Construction
	2.1.1 Local PC
	2.1.2 Connecting PBH-104
	2.1.3 Running PHPoC Debugger

	2.2 Connecting Product
	2.2.1 Connecting Product
	2.2.2 Ready to Communicate
	① Run PHPoC Debugger
	② Select connected COM PORT and press connect () button.
	③ If USB is successfully connected, connect button will be inactivated and disconnect button () will be activated.


	2.3 Practice
	2.3.1 PHPoC Operation
	2.3.2 Create "init.php"
	2.3.3 Printing Hello PHPoC
	2.3.4 Reconnecting Product

	2.4 Saving Files to PC
	2.4.1 Saving File to PC
	2.4.2 Save as a Integrated (.poc) file

	2.5 Upload Files to Product
	2.5.1 How to Add Files to File list
	2.5.2 Upload files


	3 Management
	3.1 Configure Parameters
	3.1.1 Configuration Procedure
	① Connect PHPoC product to PC
	② Run PHPoC Debugger and click connect () button.
	③ After then, click configuration () button.
	④ Configure parameters

	3.1.2 System Parameters

	3.2 Initialization
	3.2.1 Level 1
	3.2.2 Level 2

	3.3 WLAN Easy Setup
	3.3.1 SSID
	3.3.2 WLAN Connection
	3.3.3 DHCP
	3.3.4 Access to Product

	3.4 Web Interface
	3.4.1 Procedure
	3.4.2 Practical Use of Web Interface

	3.5 Firmware Upgrade
	3.5.1 Download Firmware File
	3.5.2 Firmware Upgrade
	① Connect setup port of PHPoC product to local PC via USB cable.
	② Run PHPoC Debugger and click connect () button.
	③ Click [Function] > [Upgrade Firmware] menu.
	④ Click [Open] button to select the firmware file.
	⑤ Click [Send] button.
	⑥ Firmware Upgrade Completed.


	3.6 Etcetera
	3.6.1 Debug Mode
	3.6.2 Using External Editor


	4 Technical Support and Warranty
	4.1 Technical Support
	4.2 Customer Support
	4.3 Warranty
	4.3.1 Refund
	4.3.2 Free Repair Services
	4.3.3 Charged Repair Services


	5 Precaution and Exemption from Liability
	5.1 Precaution
	5.2 Exemption from Liability
	5.2.1  English version
	5.2.2  French version


	6 Appendix
	6.1 Device Information
	6.1.1 Device overview
	6.1.2 I/O port


	7 Revision History

